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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Computer models
equipped with PM45
system board

Product Name HP Compaq 6830s Notebook PC √

Processors Intel® Core™2 Duo processors

 ● T5670 1.80-GHz processor, 2-MB L2 cache, 800-MHz front
side bus (FSB)

√

 ● T5870 2.0-GHz processor, 2-MB L2 cache, 800-MHz FSB √

 ● P8400 2.26-GHz processor, 3-MB L2 cache, 1066-MHz FSB √

 ● P8600 2.40-GHz processor, 3-MB L2 cache, 1066-MHz FSB √

 ● T9400 2.53-GHz processor, 6-MB L2 cache, 1066-MHz FSB √

 Intel Celeron® M processors

 ● 575 2.0-GHz processor, 1-MB L2 cache, 667-MHz FSB √

 ● 585 2.16-GHz processor, 1-MB L2 cache,667-MHz FSB √

Chipset Northbridge: Intel PM45 with up to 1066-MHz FSB √

 Southbridge: Intel ICH9M √

Graphics ATI-M82SE discrete graphics subsystem memory with
Hypermemory support

√

Panels All display assemblies include 2 wireless local area network
(WLAN) antennae

√

 ● 17.0-inch WXGA BrightView √

 ● 17.0-inch WXGA+ √

 ● 17.0-inch WSXGA+WVA √

Memory 2 customer-accessible/upgradable memory module slots √

 Supports dual-channel memory √

 Supports up to 8 GB of system RAM √

 PC2-5300, 667-MHz, DDR2 √

1



Category Description Computer models
equipped with PM45
system board

 Supports the following configurations in all countries and regions
except Brazil:

● 8192-MB total system memory (4096 x 2, dual-channel)

● 4096-MB total system memory (4096-MB x 1, dual-channel)

● 4096-MB total system memory (2048 × 2, dual-channel)

● 3072-MB total system memory (2048 + 1024, dual-channel)

● 2048-MB total system memory (1024 × 2, dual-channel)

● 2048-MB total system memory (2048 × 1)

● 1024-MB total system memory (1024 × 1)

√

 Supports the following configurations only in Brazil:

● 3072-MB total system memory (2048 + 1024, dual-channel)

● 2048-MB total system memory (2048 × 1)

● 2048-MB total system memory (1024 × 2, dual-channel)

● 1024-MB total system memory (1024 × 1)

√

 PC2-5300, 800–MHz, DDR2 √

 Supports the following configurations in all countries and regions
except Brazil:

● 8192-MB total system memory (4096 x 2, dual-channel)

● 4096-MB total system memory (4096 x 1, dual-channel)

● 4096-MB total system memory (2048 x 2, dual-channel)

● 3072-MB total system memory (2048 + 1024, dual-channel)

● 2048-MB total system memory (2048 x 1)

● 2048-MB total system memory (1024 x 2, dual-channel)

● 1024-MB total system memory (1024 x 1)

√

 Supports the following configurations only in Brazil:

● 3072-MB total system memory (2048 + 1024, dual-channel)

● 2048-MB total system memory (2048 x 1)

● 2048-MB total system memory (1024 x 2, dual-channel)

● 1024-MB total system memory (1024 x 1)

√

Hard drives Supports 9.5-mm, 2.5-inch hard drives √

 Customer-accessible √

 Serial ATA √

 Supports Disk Sanitizer √
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Category Description Computer models
equipped with PM45
system board

 Supports full disk encryption √

 Supports HP 3D DriveGuard √

 Supports the following drives:

● 320-GB, 5400-rpm hard drive

● 250-GB, 5400-rpm hard drive

● 160-GB, 5400-rpm hard drive

● 120-GB, 5400-rpm hard drive

● 120-GB, 7200-rpm hard drive

√

Optical drives Fixed (removal of 1 screw required) √

 Customer-accessible √

 Serial ATA √

 12.7-mm tray load √

 Supports the following optical drives:

● DVD±RW SuperMulti Double-Layer Drive with LightScribe

● Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-
Layer

● DVD/CD-RW Combo Drive

● DVD-ROM Drive

√

Diskette drive Supports external USB diskette drive only √

 Supports boot from external USB diskette drive √

 Supports 3-mode diskette drive √

Audio HD audio - ADI1984 √

Modem 56K V.92 1.5-inch data/fax modem with digital line guard √

Ethernet Marvell 10/100/1000 Ethernet 88E8072–B1 √

 S3/S4/S5 wake on LAN: DC - no √

 S3/S4/S5 wake on LAN: AC - yes √

Wireless Integrated WLAN options by way of wireless module:

 2 WLAN antennae built into display assembly √

 Support for no-WLAN option √

 Support for the following WLAN formats:

● Intel 802.11a/b/g/n

● Broadcom 802.11a/b/g/n

√

3



Category Description Computer models
equipped with PM45
system board

● Broadcom 802.11b/g

● Intel 802.11a/b/g

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Support for no-WPAN option √

 Broadcom Bluetooth 2.0+EDR √

External media card One ExpressCard/54 slot √

 Media Card Reader supporting Secure Digital (SD) Memory Card,
Memory Stick, Memory Stick Pro, Memory Stick Duo,
MultiMediaCard (MMC), and xD–Picture Card formats

√

Ports Audio-in (stereo microphone) √

 Audio-out (stereo headphone) √

 RJ-11 (modem) √

 RJ-45 (Ethernet, includes link and activity lights) √

 USB (4) √

 VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at
75-Hz (hot plug/unplug with auto-detect)

√

 Headphone/Line Out √

 3-pin AC power adapter √

Keyboard/pointing
devices

11.97-inch keyboard with integrated numeric keypad √

 2–way scrolling, taps enabled as default √

 TouchPad only, with 2 TouchPad buttons √

Power requirements 90-W HP Smart AC adapter with localized cable plug support (3-
wire plug with ground pin, supports 3-pin DC connector)

√

 8-cell, 63-Wh Li-ion battery √

 6-cell, 47-Wh Li-ion battery √

 6-cell 55-Wh Li-ion battery √

Security Supports Kensington security sock √

Operating system Preinstalled:  

 Windows® Vista® Basic 32 with Office Ready √

 Windows Vista Basic 32 with Office Personal (in Japan only) √

 Windows Vista Basic 32 with Office Personal/PowerPoint (in Japan
only)

√

 Windows Vista Basic 32 with Office Professional (in Japan only) √

 Windows Vista Basic 32 √

 Windows Vista Business 32 √
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Category Description Computer models
equipped with PM45
system board

 Windows Vista Business 32 with Office Ready √

 Windows Vista Business 32 with Office Personal (in Japan only) √

 Windows Vista Business 32 with Office Personal/PowerPoint (in
Japan only)

√

 Windows Vista Business with Office Professional (in Japan only) √

 Windows Vista Business with Windows® XP Pro √

 Windows Vista Business with Windows XP Pro with Office
Personal/PowerPoint (in Japan only)

√

 Windows Vista Business with Windows XP Pro with Office
Personal (in Japan only)

√

 Windows Vista Business with Windows XP Pro with Office
Professional (in Japan only)

√

 Windows Vista Business with Windows XP Pro with Office Ready √

 Windows Vista Home Premium with Office Ready √

 FreeDOS √

 Red Flag Linux (in the People's Republic of China only) √

 Restore media:  

 Windows Vista Basic 32 √

 Windows Vista Home Premium √

 Windows Vista Business 32 √

 Windows Vista Business 64 √

 Windows XP Pro √

 Office Ready DVD √

 Red Flag Linux (in the People's Republic of China only) √

 DRDVD Windows Vista √

 DRDVD Windows XP Pro √

 Certified: Microsoft® WHQL √

 Web support:  

 Windows XP Pro √

Serviceability End-user replaceable parts:  

 AC adapter √

 Battery (system) √

 Hard drive √

 Memory module √
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Category Description Computer models
equipped with PM45
system board

 Optical drive √

 WLAN module √
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2 External component identification

Top components
Display components

Components Description

(1) Webcam light (select models only) On: The integrated camera is in use.

(2) Webcam (select models only) Records audio and video and captures still photographs.

Wireless antennae (select models only)
On select computer models, at least 2 antennae send and receive signals from one or more wireless
devices. These antennae are not visible from the outside of the computer.
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NOTE: For optimal transmission, keep the areas immediately around the antennae free from
obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

TouchPad

Item Component Function

(1) TouchPad* Moves the pointer and selects or activates items on the
screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.
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Item Component Function

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Buttons, switch, lights, and speakers

Item Component Function

(1) Internal display switch Turns off the display if the display is closed while the power
is on.

(2) Caps lock light On: Caps lock is on.

(3) Speakers (2) Produce sound.

(4) Wireless light ● Blue: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Broadband Wireless Module, and/or a Bluetooth®
device, is on.

● Amber: All wireless devices are off.

(5) Wireless button Turns the wireless feature on or off, but does not establish
a wireless connection.

NOTE: You must set up or access a wireless network to
establish a wireless connection.

(6) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button to turn off
the computer.

● When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
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Item Component Function

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(7) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or Standby (Windows XP).

● Off: The computer is off or in Hibernation.

Keys

Item Component Function

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) num lk key Alternates between the navigation and numeric functions
on the integrated numeric keypad.

(7) Function keys Execute frequently used system functions when pressed
in combination with the fn key.
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Front components

Item Component Function

(1) Media Card Reader Supports the Memory Stick, Memory Stick Pro, Memory
Stick Duo, Secure Digital (SD) Memory Card,
MultimediaCard (MMC), and xD-Picture Card formats.

(2) Drive light ● Blinking turquoise: The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

(3) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

(4) Internal microphone Records sound.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

Right-side components

Item Component Function

(1) USB ports (2) Connect optional USB devices.

(2) Optical drive Reads an optical disc.

(3) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Left-side components

Item Component Function

(1) RJ-11 (modem) jack Connects a modem cable.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) External monitor port Connects an external VGA monitor or projector.

(4) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(5) Power connector Connects an AC adapter.

(6) RJ-45 (network) jack Connects a network cable.

(7) USB ports (2) Connect optional USB devices.

(8) ExpressCard slot Supports optional ExpressCards.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) Memory module compartment Contains a memory module.

(5) Hard drive bay Holds the hard drive.

(6) WLAN module compartment (select models only) Contains a WLAN module slot.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.
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3 Illustrated parts catalog

Serial number location
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number you use to locate documents, drivers, and support for your
computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.
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Computer major components

Item Description Spare part number

(1) Display assemblies (include 2 WLAN antenna transceivers and cables)

 17.0-inch, WXGA BrightView display assembly 490332-001

 17.0–inch WXGA BrightView display assembly with webcam 495897–001

 17.0-inch, WXGA Anti-Glare display assembly 490334-001
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Item Description Spare part number

 17.0-inch, WXGA WVA display assembly 490333-001

 17.0-inch, WXGA WVA display assembly with webcam 495898-001

 17.0–inch WXGA Anti-Glare display assembly with webcam 495899–001

 Display internal components: not illustrated

 Display bezel without webcam 490328-001

 Display bezel with webcam 495738-001

 Display enclosure (includes 2 WLAN antenna transceivers and cables) 490331-001

 Display hinges (includes left and right hinges) 490329-001

 Display inverter 490326-001

(2) Switch cover (includes LED board and cable) 490315-001

(3) LED power button board (included with the switch cover, spare part number 490315-001)  

(4) Speakers 490341-001

(5) Keyboards

 For use in Saudi Arabia 490327-171

 For use in Brazil 490327-201

 For use in the Czech Republic 490327-221

 For use in Denmark 490327-081

 For use in Europe 490327-021

 For use in Belgium 490327-A41

 For use in French Canada 490327-121

 For use in France 490327-051

 For use in Greece 490327-151

 For use in Germany 490327-041

 For use in Israel 490327-BB1

 For use in Hungary 490327-211

 For use in Iceland 490327-DD1

 For use in Italy 490327-061

 For use in Japan 490327-291

 For use in South Korea 490327-AD1

 For use in Latin America 490327-161

 For use in Portugal 490327-131

 For use in Russia 490327-251

 For use in Sweden and Finland 490327-B71

 For use in Slovakia 490327-231
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Item Description Spare part number

 For use in Slovenia 490327-BA1

 For use in Spain 490327-071

 For use in Switzerland 490327-111

 For use in Thailand 490327-281

 For use in Turkey 490327-141

 For use in Taiwan 490327-AB1

 For use in the United Kingdom 490327-031

 For use in the United States 490327-001

(6) Top cover (includes TouchPad board and cable, and TouchPad button board and cable) 490342-001

(7) RJ–11 connector (included in cable kit, spare part number 490314-001)  

(8) TouchPad (Included with top cover, spare part number 490342-001)  

(9) Plastics Kit (see Plastics Kit on page 22 for more Plastics Kit spare part information): 490335-001

(9a) ExpressCard slot bezel

(9b) WLAN module compartment cover

(9c) Hard drive bay cover

(9d) Memory module compartment cover

(10) TouchPad cable (included with top cover, spare part number 490342-001)  

(11) TouchPad bracket  (included with top cover, spare part number 490342-001)  

(12) Heat sink  (includes replacement thermal material) 490325-001

(13) Fan 490324-001

(14) Broadcom Bluetooth modules (do not include Bluetooth module cable)

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module cable
is included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23 for more Cable Kit spare part
number information.

 For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

 For use only in Japan and Asia Pacific countries and regions 450066-001

(15) USB connector and cable 490313-001

(16) Modem 461749-001

(17) System boards (includes replacement thermal material and the ExpressCard assembly)

 Iincludes 128-MB of graphics subsystem memory 490311-001

 Iincludes 256-MB of graphics subsystem memory 490312-001

(18) Optical drive connector board 490310-001

(19) Battery extender board 490308-001

 Processors (includes replacement thermal material) (not illustrated)

 Intel Core2 Duo processors:  

18 Chapter 3   Illustrated parts catalog



Item Description Spare part number

 ● P8400 2.26GHz (3-MB L2 cache, 1066-MHz FSB) 491486–001

 ● P8600 2.40-GHz (3-MB L2 cache, 1066-MHz FSB) 491487–001

 ● T9400 2.53-GHz (6-MB L2 cache, 1066-MHz FSB) 491489–001

 ● T5670 1.80-GHz (2-MB L2 cache, 800-MHz FSB) (not available for Japan)* 491488-001

 ● T5870 2.0-GHz (2-MB L2 cache, 800-MHz FSB)* 490338-001

 *Only available with Intel WLAN or no WLAN  

 Intel Celeron M processors:

 ● 575 2.0-GHz (1-MB L2 cache, 667-MHz FSB) 490336-001

 ● 585 2.16-GHz (1-MB L2 cache, 667-MHz FSB) 490337-001

(20) RTC battery 449137-001

(21) Modem modules

NOTE: The modem module spare part kit does not include a modem module cable. The modem module cable is
included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23 for more Cable Kit spare part
number information.

 For use only in all countries and regions except Australia and New Zealand 461749-001

 For use only in Australia and New Zealand 461749-011

(22) 8-cell, 63-Wh Li-ion battery 490306–001

(23) Base enclosure (includes rubber feet) 490305-001

 Rubber Kit (not illustrated, contains 7 computer feet and 8 display bezel screw covers) 490339-001

(24) Optical drives (include bezel and bracket)

 Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer 490316–001

 DVD-ROM Drive 490317-001

 DVD±RW SuperMulti Double-Layer Drive with LightScribe 490318-001

 DVD/CD-RW Combo Drive 490319-001

 Cable Kit (not illustrated; see Cable Kit on page 23 for more Cable Kit spare part number
information)

490314-001

(25) WLAN modules

 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions
except Pakistan, Russia, and the Ukraine

480985-001

 Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use only in Pakistan, Russia, and
the Ukraine

482957-001

 Broadcom BCM4312 802.11/b/g WLAN modules:

 ● For use in Antigua and Barbuda, Argentina, Aruba, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and
the United States

459263-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,

459263-002
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Item Description Spare part number

Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of
Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia,
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

 Broadcom 4322 802.11a/b/g/n WLAN modules:

 ● For use in Antigua & Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

487330-001

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Columbia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of
Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi
Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia,
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

487330-002

(26) Hard drives (include hard drive bracket)

 320–GB, 5400–rpm 498310–001

 250–GB, 5400–rpm 490323–001

 160-GB, 5400-rpm 490322-001

 120-GB, 5400-rpm 490320-001
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Item Description Spare part number

 120-GB, 7200-rpm 490321-001

(27) Memory modules (PC2-5300, 667-MHz, DDR2)

 1-GB 495175-001

 2-GB 495176-001

 Memory modules (PC2-6400, 667–MHz, DDR2)  

 1-GB 491483–001

 2-GB 491484–001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 490335-001

(1) ExpressCard slot bezel

(2) WLAN module compartment cover (includes one captive screw, secured by a C-clip)

(3) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(4) Hard drive bay cover (includes 2 captive screws, secured by C-clips)
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Cable Kit

Item Description Spare part number

 Cable Kit: 490314-001

(1) RJ-11 jack cable

(2) Display lid switch module and cable

(3) Bluetooth module cable
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Mass storage devices

Item Description Spare part number

(1) Optical drives (include bezel and bracket)

 DVD±RW SuperMulti Double-Layer Drive with LightScribe 490318-001

 Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer 490316-001

 DVD/CD-RW Combo Drive 490319-001

 DVD–ROM Drive 490317–001

(2) Hard drives (include bracket)

 320-GB, 5400-rpm 498310-001

 250-GB, 5400-rpm 490323-001

 160-GB, 5400-rpm 490322-001

 120-GB, 5400-rpm 490320-001

 120-GB, 7200 rpm 490321-001
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Miscellaneous parts
Description Spare part number

AC adapter

90-W HP Smart AC adapter for use in all countries and regions except India 463955-001

Carrying cases  

HP Universal Nylon Case 439425-001

HP Executive Leather Case 439427-001

HP Deluxe Nylon Backpack 439426–001

HP Deluxe Roller Case 446929-001

USB 1.1 diskette drive 359118-001

Power cords:

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-201

For use in Denmark 490371-081

For use in Europe 490371-021

For use in Iceland 490371-BB1

For use in India 490371-D61

For use in Italy 490371-061

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom 490371-031

For use in the United States 490371-001

Screw Kit

● Phillips PM2.0×2.0 broad-head screw

● Phillips PM2.0x3.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.5×4.0 screw

● Phillips PM2.5x6.0 captive screw

● Phillips PM2.5x9.0 screw

490340-001
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Description Spare part number

● Phillips PM3.0×4.0 screw

● Phillips PM2.5×10.0 captive screw

● Torx T8M2.0x2.0 broad-head screw

● Torx T8M2.5×7.0 slotted screw

● Torx T8M2.5×6.0 screw

● Torx T8M2.5×4.0 screw

● Torx T8M2.5×5.0 broad-head screw

● Torx T8M2.5×10.0 slotted screw
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Sequential part number listing
Spare part
number

Description

398393-002 Bluetooth module for use in North America

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23 for more
Cable Kit spare part number information.

439425-001 HP Universal Nylon Case 

439426-001 HP Deluxe Nylon Backpack 

439427-001 HP Executive Leather Case 

446929–001 HP Deluxe Roller Case 

449137-001 RTC battery

450066-001 Bluetooth module for use in Japan and Asia Pacific countries and regions

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23 for more
Cable Kit spare part number information.

459263-001 Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Argentina, Aruba, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and
the United States

459263-002 Broadcom BCM4312 802.11/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

461749-001 Modem module for use in all countries and regions except Australia and New Zealand 

NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23 for more Cable
Kit spare part number information.

461749-011 Modem module for use only in Australia and New Zealand

NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23 for more Cable
Kit spare part number information.

463955-001 90-W HP Smart AC adapter for use in all countries and regions except India 
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Spare part
number

Description

480985-001 Intel Wi–Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except Pakistan, Russia,
and the Ukraine

482957-001 Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use only in Pakistan, Russia, and the Ukraine 

487330-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States 

487330-002 Broadcom 4322 802.11a/b//n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua
and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, the People's Republic of China, Columbia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St.
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

490305-001 Base enclosure (includes rubber feet)

490306-001 8-cell, 63-Wh Li-ion battery

490308-001 System board battery connector 

490310-001 System board optical disc drive connector 

490311-001 System board with 128-MB of graphics subsystem memory (Includes replacement thermal material, and the
ExpressCard assembly)

490312-001 System board with 256-MB of graphics subsystem memory (Includes replacement thermal material, and the
ExpressCard assembly)

490313-001 USB connectors, system board 

490314-001 Cable Kit (see Cable Kit on page 23 for more Cable Kit spare part information)

490315-001 Switch cover (includes LED board and cable)

490316-001 Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer (includes bezel and bracket)

490317-001 DVD-ROM Drive

490318-001 DVD±RW SuperMulti Double-Layer Drive with LightScribe (includes bezel and bracket)

490319-001 DVD/CD-RW Combo Drive (includes bezel and bracket)

490320-001 120-GB, 5400-rpm hard drive (includes bracket) 

490321-001 120-GB, 7200-rpm hard drive (includes bracket)

490322-001 160-GB, 5400-rpm hard drive (includes bracket)

490323-001 250-GB, 5400-rpm hard drive (includes bracket)
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Spare part
number

Description

490324-001 Fan

490325-001 Heat sink (includes replacement thermal material) 

490326-001 Display inverter

490327-001 Keyboard for use in the United States

490327-021 Keyboard for use anywhere in Europe

490327-031 Keyboard for use in the United Kingdom

490327-041 Keyboard for use in Germany

490327-051 Keyboard for use in France.

490327-061 Keyboard for use in Italy

490327-071 Keyboard for use in Spain

490327-081 Keyboard for use in Denmark

490327-111 Keyboard for use in Switzerland

490327-121 Keyboard for use in French Canada

490327-131 Keyboard for use in Portugal

490327-141 Keyboard for use in Turkey

490327-151 Keyboard for use in Greece

490327-161 Keyboard for use in Latin America

490327-171 Keyboard for use in Saudi Arabia

490327-201 Keyboard for use in Brazil

490327-211 Keyboard for use in Hungary

490327-221 Keyboard for use in the Czech Republic

490327-231 Keyboard for use in Slovakia

490327-251 Keyboard for use in Russia

490327-281 Keyboard for use in Thailand

490327-291 Keyboard for use in Japan

490327-A41 Keyboard for use in Belgium

490327-AB1 Keyboard for use in Taiwan

490327-AD1 Keyboard for use in South Korea

490327-B71 Keyboard for use in Sweden and Finland

490327-BA1 Keyboard for use in Slovenia

490327-BB1 Keyboard for use in Israel

490327-DD1 Keyboard for use in Iceland

490328-001 Display bezel

490329-001 Bracket kit with display hinges (includes left and right hinges)
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Spare part
number

Description

490330-001 LCD cable

490331-001 Display enclosure (includes 2 wireless antenna transceivers and cables 

490332-001 17.0-inch, WXGA display assembly with BrightView (includes 2 WLAN antenna transceivers and cables)

4490333-001 17.0-inch, WXGA display assembly with WVA (includes 2 WLAN antenna transceivers and cables)

490334-001 17.0-inch, WXGA display assembly with Anti-Glare (includes 2 WLAN antenna transceivers and cables)

490335-001 Plastics Kit (see Plastics Kit on page 22 for more Plastics Kit spare part information)

490336-001 Intel Celeron M 575 2.0-GHz processor (1-MB L2 cache, 667-MHz FSB, includes replacement thermal
material)

490337-001 Intel Celeron M 585 2.16-GHz processor (1-MB L2 cache, 667-MHz FSB, includes replacement thermal
material)

490338-001 Intel Core2 Duo T5870 2.00-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

490339-001 Rubber Kit (contains 6 computer feet and 8 display bezel screw covers)

490340-001 Screw Kit

490341-001 Speakers

490342-001 Top cover (includes TouchPad board and cable, and TouchPad button board and cable)

490371-D01 Power cord for use in Argentina

490371-011 Power cord for use in Australia and New Zealand

490371-201 Power cord for use in Brazil

490371-081 Power cord for use in Denmark

490371-021 Power cord for use in European countries

490371-BB1 Power cord for use in Iceland

490371-D61 Power cord for use in India

490371-061 Power cord for use in Italy

490371-291 Power cord for use in Japan

490371–AA1 Power cord for use in the People's Republic of China

490371-AR1 Power cord for use in South Africa

490371-AD1 Power cord for use in South Korea

490371-111 Power cord for use in Switzerland

490371-AB1 Power cord for use in Taiwan

490371-031 Power cord for use in the United Kingdom

490371-001 Power cord for use in the United States

491486-001 Intel Core2 Duo P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB, includes replacement thermal
material)

491487-001 Intel Core2 Duo P8600 2.40-GHz processor (32-MB L2 cache, 1066-MHz FSB, includes replacement thermal
material)
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Spare part
number

Description

491489-001 Intel Core2 Duo T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB, includes replacement thermal
material)

491488-001 Intel Core2 Duo T5670 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

495175-001 1-GB memory module (PC2-5300, 667-MHz, DDR2)

495176-001 2-GB memory module (PC2-5300, 667-MHz, DDR2)

495897-001 17.0-inch, WXGA display assembly with BrightView and webcam (includes 2 WLAN antenna transceivers and
cables)

495898-001 17.0-inch, WXGA display assembly with WVA and webcam (includes 2 WLAN antenna transceivers and
cables)

495899-001 17.0-inch, WXGA display assembly with AG and webcam (includes 2 WLAN antenna transceivers and cables)

498310-001 320-GB, 5400-rpm hard drive (includes bracket)

 TouchPad board (included with top cover, spare part number 490342-001) (includes cable)

 TouchPad button board (included with top cover, spare part number 490342-001) (includes cable)
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 66).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 99 screws, in 14 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number
The service tag, affixed to the bottom of the computer, provides information that may be needed when
troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the number you use to locate documents, drivers, and support for your
computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 490339-001. There are 7 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

8-cell, 63-Wh Li-ion battery 490306-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number

320-GB, 5400-rpm hard drive 498310–001

250-GB, 5400–rpm hard drive 490323–001

160-GB, 5400-rpm hard drive 490322-001

120-GB, 5400-rpm hard drive 490320-001

120-GB, 7200-rpm hard drive 490321-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips 6.0-mm captive screws (1) that secure the hard drive bay cover to the
computer.

3. Lift the right side of the hard drive bay cover (2), swing it to the left, and remove the cover (3). The
hard drive bay cover is included in the Plastics Kit, spare part number 490335-001.
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4. Loosen the Phillips 10.0-mm captive screw (1) that secures the hard drive to the computer.

5. Grasp the Mylar tab (2) on the hard drive and slide the hard drive to the left to disconnect it from
the system board.

6. Remove the hard drive (3) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the four Phillips 4.0-mm hard drive
bracket screws (1) from each side of the hard drive.

8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description Spare part number

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except
Pakistan, Russia, and the Ukraine

480985-001

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use only in Pakistan, Russia, and the Ukraine 482957-001

Broadcom BCM4312 802.11b/g WLAN module  

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States 459263-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

Broadcom 4322 802.11a/b/g/n WLAN modules:

● For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

487330-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Columbia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,

487330-002
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Description Spare part number

Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Loosen the Phillips 6.0-mm captive screw (1) that secures the WLAN module compartment cover
to the computer.

3. Lift the right side of the WLAN module compartment cover, swing it to the left, and remove the
cover (2). The WLAN module compartment cover is included in the Plastics Kit, spare part number
490335-001.

4. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

5. Remove the two Phillips 4.0-mm screws (2) that secure the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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6. Remove the WLAN module (3) by sliding the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.

Memory module

Description Spare part number

1-GB (PC2-5300, 667-MHz, DDR2) 495175-001

2-GB (PC2-5300, 667-MHz, DDR2) 495176-001

1-GB (PC2-6400, 667-MHz, DDR2) 491483-001

2-GB (PC2-6400, 667-MHz, DDR2) 491484-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the memory module:

1. Loosen the Phillips 6.0-mm captive screw (1) that secures the memory module compartment cover
to the computer.
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2. Lift the front edge of the cover (2), swing it up and back, and remove the cover (3). The memory
module compartment cover is included in the Plastics Kit, spare part number 490335-001.

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW Double-Layer 490316-001

DVD±RW SuperMulti Double-Layer Drive with LightScribe 490318-001

DVD/CD-RW Combo Drive 490319-001

DVD-ROM Drive 490317-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the Torx 7.0-mm screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips 3.0-mm screws (1) that secure the optical drive bracket to the optical drive.

Component replacement procedures 47



7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.
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Switch cover and keyboard

Description Spare part number

Switch cover (includes button board and cable) 490315-001

Keyboards for use in the following countries or regions:

Brazil 490327-201 Latin America 490327-161

The Czech Republic 490327-221 Portugal 490327-131

Denmark 490327-081 Russia 490327-251

Europe 490327-021 Saudi Arabia 490327-171

Belgium 490327-A41 Slovakia 490327-231

France 490327-051 Slovenia 490327-BA1

French Canada 490327-121 South Korea 490327-AD1

Germany 490327-041 Spain 490327-071

Greece 490327-151 Sweden and Finland 490327-B71

Hungary 490327-211 Switzerland 490327-111

Iceland 490327-DD1 Taiwan 490327-AB1

Israel 490327-BB1 Thailand 490327-281

Italy 490327-061 Turkey 490327-141

Japan 490327-291 The United Kingdom 490327-031

  The United States 490327-001

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).
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Remove the switch cover and keyboard:

1. Remove the following screws:

(1) Two Slotted Torx 10.0-mm screws

(2) Three Torx 2.0-mm broad-head screws

2. Remove the two Torx 7.0-mm screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.
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5. Lift the switch cover (1) straight up until it disengages from the computer, and slide it back (2) until
it rests on the display assembly.

6. Lift up the rear edge of the keyboard (1), and slide it back (2) to disengage the four tabs on the
front of the keyboard from the switch cover.
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7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

9. Release the ZIF connector and disconnect the LED ribbon cable from the system board (1), and
then lift the switch cover up to remove it (2) from the system board.

10. Turn the switch cover over.

11. Remove the two Phillips 2.0-mm broadhead screws (1) from the switch cover.
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12. Remove the LED power button board (2) from the switch cover.

Reverse this procedure to install the switch cover and keyboard.
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Speakers

Description Spare part number

Speakers 490341-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the keyboard (see Switch cover and keyboard on page 49).

6. Remove the switch cover (see Switch cover and keyboard on page 49).

Remove the speakers:

1. Disconnect the speaker cable (1) from the system board and remove the speaker cable from the
clips and routing channel.

NOTE: The two speakers are connected with a single cable.

2. Remove the four Phillips 4.0-mm screws (2) that secure the speakers to the top cover.

3. Remove the speakers (3) from the top cover.

Reverse this procedure to install the speakers.
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Display assembly
NOTE: All display assembly spare part kits include 2 WLAN antenna transceivers and cables.

Description Spare part number

17-inch, WXGA BrightView display assembly 490332-001

17-inch, WXGA BrightView display assembly with webcam 495897-001

17-inch, WXGA WVA display assembly 490333-001

17-inch, WXGA WVA display assembly with webcam 495898-001

17-inch, WXGA +Anti-Glare display assembly 490334-001

17-inch, WXGA + Anti-Glare display assembly with webcam 495899-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 43).

6. Remove the following components:

a. Keyboard (see Switch cover and keyboard on page 49)

b. Switch cover (see Switch cover and keyboard on page 49)

c. Speakers (see Speakers on page 54)

Remove the display assembly:

1. Open the computer as far as possible.

2. Disconnect the display panel cable (1) from the system board.

CAUTION: There is a ground loop off the display panel cable that is secured to the left hinge. Be
sure you do not pull or damage the cable.

3. Disconnect the webcam and microphone module cables (2) from the system board and then
remove the cables from the routing path (3).
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4. Make sure that the wireless antenna cables are disconnected from the WLAN module on the bottom
of the computer, then remove the wireless antenna cables (4) from the clips and routing channels
built into the top cover.

CAUTION: Support the display assembly when removing the following screws. Failure to support
the display assembly can result in damage to the display assembly and other computer
components.

5. Remove the two Slotted Torx 10-mm screws (1) and the two Torx 7.0-mm screws (2) that secure
the display assembly to the computer.

6. Release the display panel cable ground loop (3) from the system board.

7. Lift the display assembly (4) straight up and remove it.
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8. If it is necessary to replace the display bezel, display inverter, or display hinges, remove the eight
rubber screw covers (1) and the eight Torx 6.0-mm screws (2) that secure the display bezel to the
display assembly. The rubber screw covers are available in the Rubber Kit, spare part number
490339-001.

9. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.

10. Remove the display bezel (3). The display bezel is available using spare part number
495738-001.
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11. If it is necessary to replace the webcam module from the display enclosure, gently pull the webcam
module from the double-sided tape on the display enclosure (1) and disconnect the webcam cable
from the module (2).

NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

12. If it is necessary to replace the display inverter, remove the inverter (1) from the display enclosure
as far as the display panel cable and the backlight cable will allow.

13. Disconnect the display panel cable (2) and the backlight cable (3) from the display inverter.

14. Remove the display inverter. The display inverter is available using spare part number
490326-001.

15. If it is necessary to replace the display hinges, remove the two Torx 6.0-mm screws (1) that secure
the display panel to the display enclosure.
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16. Remove the display panel (2).

17. Remove the eight Phillips 3.0-mm screws (1) that secure each display hinge to the display
panel.

NOTE: When removing or replacing the Phillips screws, be sure to remove or replace them in
the same sequence as the numbering found on the display hinges (1–2–3–4).

18. Remove the display hinges (2). The left and right display hinges are available using spare part
number 490329-001.

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover 490342-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the 12 top cover slotted Torx 7.0-mm screws.
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3. Remove the three Phillips 2.0-mm broad-head screws from the optical drive bay (1), and remove
the Torx 4.0-mm screw from the hard drive bay (2).

4. Turn the computer right-side up.

5. Remove the three slotted Torx 7.0-mm screws from the top cover.

6. Lift the rear edge of the top cover (1) until it disengages from the base enclosure. Then tilt the top
cover back (2) until the TouchPad cable is accessible.
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7. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
TouchPad cable (2) from the system board.

8. Remove the top cover.

Reverse this procedure to install the top cover.
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USB board 
1. Disconnect the USB cable from the system board (1).

2. Lift up the USB connector and remove the cable from the cable routing path (2).

3. Remove the Phillips 9.0-mm screw (3) and the Phillips 4.0-mm screw (4) from the system board.

4. Remove the USB board (5).

Reverse this procedure to install the USB board.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23
for more Cable Kit spare part number information.

Description Spare part number

For use in all countries and regions except Japan and Asia Pacific countries and regions 398393-002

For use only Japan and Asia Pacific countries and regions 450066-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

g. Top cover (see Top cover on page 60)

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Remove the Bluetooth module cable (2) from the routing path.

3. Remove the Phillips 4.0-mm screw (3) that secures the Bluetooth module to the base enclosure.
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4. Remove the Bluetooth module (4) from the base enclosure.

Reverse this procedure to install the Bluetooth module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

g. Top cover (see Top cover on page 60)

h. System board (see System board on page 68)

Remove the RTC battery:

1. Turn the system board upside down, with the audio connectors toward you.
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2. Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.
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System board
NOTE: All system board spare part kits include the ExpressCard assembly.

NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

System board includes 128-MB of graphics subsystem memory 490311-001

System board includes 256-MB of graphics subsystem memory 490312-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

g. Top cover (see Top cover on page 60)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● Memory module (see Memory module on page 45)

● WLAN module (see WLAN module on page 43)

● Processor (see Processor on page 76)

To remove the system board:

1. Remove the four Phillips 4.0-mm screws (1) that secure the optical drive connector board to the
base enclosure.

2. Remove the Torx 6.0-mm screw (2) that secures the system board to the base enclosure.
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3. Remove the three Torx 6.0-mm screws (3) that secure the battery connector board to the base
enclosure.

4. Flex the left side of the base enclosure until the external monitor connector (1) and the heat sink
(2) are clear of the openings in the base enclosure.

5. Lift the rear edge of the system board (3) until it rests at an angle.

6. Remove the system board (4) from the base enclosure by sliding it back.

Reverse the preceding procedure to install the system board.
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Fan

Description Spare part number

Fan 490324-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

g. Top cover (see Top cover on page 60)

h. System board (see System board on page 68)

Remove the fan:

1. Remove the two Torx 6.0-mm screws (1) that secure the fan to the base enclosure.
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2. Remove the fan (2) from the base enclosure.

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 490314-001. See Cable Kit on page 23
for more Cable Kit spare part number information.

Description Spare part number

For use in all countries and regions except Australia and New Zealand 461749-001

For use only in Australia and New Zealand 461749-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

g. Top cover (see Top cover on page 60)

h. System board (see System board on page 68)

Remove the modem module:

1. Turn the system board upside down, with the audio connectors toward you.

2. Remove the two Phillips 4.0-mm screws (1) that secure the modem module to the system board.

3. Lift the modem module (2) straight up to release it from the system board.
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4. Disconnect the modem module cable (3) .

5. Remove the modem module.

Reverse this procedure to install the modem module.
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Heat sink
NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

Heat sink (includes replacement thermal material) 490325-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

g. Top cover (see Top cover on page 60)

h. System board (see System board on page 68)

Remove the heat sink:

1. Turn the system board upside down, with the audio connectors toward you.

2. Remove the two Phillips 10-mm captive screws from the heat sink extension (1).

3. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four Phillips 10-mm captive
screws (2) around the processor.
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4. Remove the heat sink (3).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system
board (1), (2), and (3), and the heat sink components (4) and (5) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include replacement thermal material.

Description Spare part number

Intel Core2 Duo processors  

● P8400 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB) 491486-001

● P8600 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB) 491487-001

● T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 491489-001

● T5670 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB) 491488-001

● T5870 2.0-GHz processor (2-MB L2 cache, 800-MHz FSB) 490388-001

Intel Celeron M Processors  

● Cel-575 2.0-GHz processor (1-MB, 667-MHz FSB) 490336-001

● Cel-585 2.16-GHz processor (1-MB, 667-MHz FSB) 490337-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Switch cover and keyboard on page 49)

d. Switch cover (see Switch cover and keyboard on page 49)

e. Speakers (see Speakers on page 54)

f. Display assembly (see Display assembly on page 55)

g. Top cover (see Top cover on page 60)

h. System board (see System board on page 68)

Remove the processor:

1. Turn the system board upside down, with the USB connectors toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.
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3. Lift the processor (2) straight up and remove it.

NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup:

1. Turn on or restart the computer.

2. Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation
and selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the
system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Enable/disable the fingerprint reader (select models only;
disabled by default).

Allow reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the selected
drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Diagnostics menu

Select To do this

Hard Drive Self-Test options Run a comprehensive self-test on any hard drive in the system.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette
drive, or optical drive connected by a USB port to the computer or to an
optional docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD PSAE Execution
Disable. When enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.
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Select To do this

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay II devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 28.50 cm 11.22 in

Width 39.60 cm 15.60 in

Height (front to rear) 3.23 to 3.58 cm 1.27 to 1.41 in

Weight (equipped with optical drive, hard drive, and battery) 2.95 kg 6.50 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

17.0-inch, WXGA+WVA display specifications
 Metric U.S.

Dimensions

Height 24.4 cm 9.6 in

Width 38.1 cm 15.0 in

Diagonal 43.2 cm 17.0 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.259 × 0.259 mm

Format 1440 × 900

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 6.5 W

Viewing angle +/-45 horizontal, +15/–35° vertical (typical)
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Hard drive specifications
 320-GB 250-GB* 160-GB* 120-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms 24 ms

Logical blocks 625,141,400 488,376,120 312,560,640 234,420,480

Disc rotational speed 5400 rpm 5400 rpm 5400 rpm 7200 and
5400 rpm

Operating temperature   5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray Disc ROM Drive with SuperMulti DVD±R/RW
Double-Layer specifications

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-
R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-
ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode
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DVD±RW SuperMulti Double-Layer Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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DVD/CD-RW Combo Drive specifications
Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2
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DVD-ROM Drive specifications
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,

CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R, CD-
RW, Photo CD (single and multisession), CD-Bridge

Access time CD DVD

Random < 100 ms < 125 ms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 ExpressCard controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
490340-001.
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Phillips PM2.0×2.0 broad-head screw

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 5.0 mm

Where used: 3 screws that secure the top cover to the display enclosure
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Phillips PM2.0x2.0 broad-head screw

Color Quantity Length Thread Head diameter

Black 2 2.0 mm 2.0 mm 6.0 mm

Where used: 2 screws that secure the button board to the switch cover
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 10 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 8 screws that secure the display hinges to the display assembly
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Phillips PM2.0x4.0 screw

Color Quantity Length Thread Head diameter

Black 5 4.0 mm 2.0 mm 4.5 mm

Where used: 1 screw that secures the Blueotooth module to the base enclosure

Where used: 4 screws that secure the optical drive connector board to the system board
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Silver 2 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the system board
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 9 4.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the speakers to the system board

Where used: 2 wireless antenna transceiver screws that secure the transceiver to the base enclosure
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Where used: 2 screws that secure the modem module to the system board

Where used: 1 screw that secures the USB board to the base enclosure
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Phillips PM2.5×6.0 captive screw

Color Quantity Length Thread Head diameter

Black 4 6.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two captive screws that secure the hard drive bay cover to the computer (screws are secured by C-
clips)

(2) One captive screw that secures the WLAN module compartment cover to the computer (screw is
secured by a C-clip)

(3) One captive screw that secures the memory module compartment cover to the computer (screw is
secured by a C-clip)
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Phillips PM2.5×9.0 screw

Color Quantity Length Thread Head diameter

Black 1 9.0 mm 2.5 mm 4.5 mm

Where used: 1 screw that secures the USB board to the base enclosure
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Phillips PM2.5×10.0 captive screw

Color Quantity Length Thread Head diameter

Black 1 10.0 mm 2.5 mm 5.0 mm

Where used: One captive screw that secures the hard drive to the computer (screw is secured to the
hard drive bracket)
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Phillips PM2.5x10.0 captive screw

Color Quantity Length Thread Head diameter

Silver 6 10.0 mm 2.5 mm 5.9 mm

Where used: 6 captive screws that secure the heat sink to the system board (screws are secured to
the heat sink by C-clips)

Phillips PM3.0×4.0 screw

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Phillips PM2.5x10.0 captive screw 107



Where used: 4 screws that secure the hard drive bracket to the hard drive

Slotted Torx ST8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 19 7.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) Twelve screws that secure the switch cover to the computer
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Where used: 2 screws that secure the display assembly to the computer

Where used: 3 screws that secure the top cover to the base enclosure

Where used: 1 screw that secures the top cover to the base enclosure
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Torx T8M2.5×5.0 broad-head screw

Color Quantity Length Thread Head diameter

Black 2 5.0 mm 2.5 mm 8.0 mm

Where used: 2 screws that secure the display panel to the display assembly
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Torx T8M2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 1 4.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the top cover to the base enclosure

Torx T8M2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 16 6.0 mm 2.5 mm 5.0 mm
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Where used: 8 screws that secure the display bezel to the display assembly

Where used: Two screws that secure the display panel to the display assembly

Where used:

(1) One screw that secures the system board to the base enclosure

(2) Three screws that secure the battery connector board to the base enclosure
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Where used: Two screws that secure the fan to the base enclosure
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Slotted Torx T8M2.0x2.0 screw

Color Quantity Length Thread Head diameter

Black 2 2.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the switch cover to the base enclosure
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Slotted Torx T8M2.5x10.0 screw

Color Quantity Length Thread Head diameter

Black 6 10.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the switch cover and keyboard to the base enclosure

Where used: 2 screws that secure the display assembly to the base enclosure
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8 Backup and recovery

Backup and recovery in Windows Vista
Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery 
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section
in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information 
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
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NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the display inverter
(2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part

number 27
AC adapter, spare part

numbers 25
antenna, disconnecting 44
antennae 7
audio, product description 3
audio-in jack

location 12
pin assignments 122

audio-out jack
location 12
pin assignments 123

B
backing up, Windows Vista 116
backing up, Windows XP 120
Backup and Restore

Center 116,  117
base enclosure, spare part

number 19,  28
battery

location 14
removal 40
spare part number 19,  28, 

40
battery bay 14
battery connector, system board

spare part number 28
battery extender board, spare part

number 18
battery latches 14
battery light 13
BIOS Administrator password 81
Blu-ray Disc ROM Combo Drive

precautions 33
removal 47

spare part number 19,  24, 
28

specifications 87
Bluetooth module

removal 64
spare part numbers 18,  27, 

64
Bluetooth module cable,

illustrated 23
boot options 82
boot order 82
bottom components 14
button components 10
buttons

power 10
TouchPad 8,  9
wireless 10

C
Cable Kit

contents 23
spare part number 19,  23, 

28
cable, LCD 30
cables, service considerations 33
caps lock light 10
carrying cases, spare part

number 25
chipset, product description 1
CMOS clearing 37
components

bottom 14
buttons 10
front 12
keys 11
left-side 13
lights 10
pointing devices 8
right-side 12
speakers 10

top 7
TouchPad 8

computer feet
locations 39
spare part number 39

Computer Setup
accessing 78
Diagnostics menu 81
File menu 80
navigating and selecting 79
restoring factory settings 79
Security menu 81
System Configuration

menu 82
using 79

computer specifications 84
connectors

power 13
service considerations 33

D
Diagnostics menu 81
discs

Driver Recovery 121
Operating System 121

Disk Sanitizer 81
diskette drive

precautions 33
product description 3
spare part number 25

display assembly
removal 55
spare part number 16,  30, 

31,  55
display bezel

removal 57
spare part number 17,  29, 

57
display component recycling 129
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display enclosure, spare part
number 17,  30

display hinge
removal 59
spare part number 17,  29, 

59
display inverter

removal 58
spare part number 17,  29, 

58
display lid switch module

illustrated 23
display panel, removal 58
display specifications 85
drive light 12
DriveLock password 81
DriveLock, automatic 81
Driver Recovery disc 121
drives

boot order 82
preventing damage 33

DVD-ROM Drive
removal 47
spare part number 19,  24, 

28
specifications 90

DVD/CD-RW Combo Drive
precautions 33
removal 47
spare part number 19,  24, 

28
specifications 89

DVD±RW SuperMulti Double-layer
Combo Drive

specifications 88
DVD±RW SuperMulti Double-layer

Drive w/LightScribe
precautions 33
removal 47
spare part number 19,  24, 

28

E
electrostatic discharge 34
esc key 11
Ethernet, product description 3
Execution Disable 82
ExpressCard assembly

spare part numbers 18
ExpressCard slot 13

ExpressCard slot bezel,
illustrated 22

external media cards, product
description 4

external monitor port
location 13
pin assignments 124

F
fan

removal 70
spare part number 18,  29, 

70
feet

locations 39
spare part number 39

File menu 80
fn key 11
front components 12
function keys 11

G
graphics, product description 1
grounding equipment and

methods 36

H
hard drive

location 14
precautions 33
product description 2
removal 41
spare part number 20,  24, 

28,  31,  41
specifications 86

hard drive bay 14
hard drive bay cover

illustrated 22
removal 41

hard drive bracket, removal 42
hard drive test 81
headphone jack

location 12
pin assignments 123

heat sink
removal 74
spare part number 18,  29, 

74

hinge
removal 59
spare part number 17,  29, 

59
HP Deluxe Nylon Backpack, spare

part number 25,  27
HP Deluxe Roller Case, spare part

number 25,  27
HP Executive Leather Case, spare

part number 25,  27
HP Universal Nylon Case, spare

part number 25,  27

I
I/O address specifications 93
internal display switch 10
interrupt specifications 92

J
jacks

audio-in 12
audio-out 12
headphone 12
microphone 12
modem 13
network 13
RJ-11 13
RJ-45 13

K
key components 11
keyboard

product description 4
removal 49
spare part numbers 17,  29, 

49
keypad keys 11
keys

esc 11
fn 11
function 11
keypad 11
num lk 11
Windows applications 11
Windows logo 11

L
LAN Power Save 82
language, changing in Computer

Setup 82
LCD cable, spare part number 30
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left-side components 13
legacy support, Universal Serial

Bus (USB) 78,  82
light components 10
lights

battery 13
caps lock 10
drive 12
power 11
webcam 7
wireless 10

M
mass storage devices, spare part

numbers 24
Media Card Reader 12
memory check 81
memory map specifications 95
memory module

product description 1
removal 45
spare part numbers 21,  31, 

45
memory module compartment 14
memory module compartment

cover
illustrated 22
removal 45

microphone jack
location 12
pin assignments 122

microphone, internal 12
model name 1
modem jack

location 13
pin assignments 125

modem module
product description 3
removal 72
spare part numbers 19,  27, 

72
modem, spare part number 18
monitor port

location 13
pin assignments 124

N
navigating in Computer Setup 79

network jack
location 13
pin assignments 126

num lk key 11

O
Operating System disc 121
operating system, product

description 4
optical disc drive connector, system

board
spare part number 28

optical drive
location 12
precautions 33
product description 3
removal 47
spare part number 19
spare part numbers 24,  47
specifications 87,  88,  89,  90

optical drive connector board
spare part number 18

P
packing guidelines 35
panels, product description 1
parallel port mode 82
password clearing 37
passwords 81
pin assignments

audio-in jack 122
audio-out jack 123
external monitor port 124
headphone jack 123
microphone jack 122
modem jack 125
monitor port 124
network jack 126
RJ-11 125
RJ-45 jack 126
Universal Serial Bus (USB)

port 126
plastic parts 32
Plastics Kit

contents 22
spare part number 18,  22, 

30
pointing device

components 8

illustrated 8
product description 4

pointing device components
TouchPad 8
TouchPad buttons 8,  9
TouchPad scroll zone 8

ports
external monitor 13
monitor 13
product description 4
Universal Serial Bus

(USB) 12,  13
power button 10
power connector 13
power cord

set requirements 127
spare part numbers 25,  30

power light 11
power requirements, product

description 4
processor

product description 1
removal 76
spare part number 30,  31
spare part numbers 18,  76

product description
audio 3
chipset 1
diskette drive 3
Ethernet 3
external media cards 4
graphics 1
hard drives 2
keyboard 4
memory module 1
modem module 3
operating system 4
optical drives 3
panels 1
pointing devices 4
ports 4
power requirements 4
processors 1
product name 1
security 4
serviceability 5
wireless 3

product name 1
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R
removal/replacement

preliminaries 32
procedures 38

restoring Computer Setup factory
settings 79

right-side components 12
RJ-11 jack

location 13
pin assignments 125
spare part number 18

RJ-11 jack cable, illustrated 23
RJ-45 jack

location 13
pin assignments 126

RTC battery
removal 66
spare part number 19,  27, 

66
Rubber Kit, spare part number 30

S
Screw Kit

contents 96
spare part number 25,  30

screw listing 96
security cable slot 12
Security menu

Automatic DriveLock 81
change password 81
Disk Sanitizer 81
DriveLock 81
fingerprint reader reset 81
HP Sparekey 81
HP Sparekey enrollment 81
password policy 81
set up BIOS Administrator

password 81
System IDs 81
user management 81

security, product description 4
selecting in Computer Setup 79
serial number 15,  38
service considerations 32
serviceability, product

description 5
speakers

removal 54
spare part number 17,  30, 

54

speakers, location 10
specifications

Blu-ray Disc ROM Combo
Drive 87

computer 84
display 85
DVD-ROM Drive 90
DVD/CD-RW Combo Drive 89
DVD±RW Combo Drive 88
hard drive 86
I/O addresses 93
interrupts 92
memory map 95
optical drive 87,  88,  89,  90
system DMA 91

startup check 81
static-shielding materials 36
switch cover

removal 49
spare part number 17,  28, 

49
switch, internal display 10
system board

removal 68
spare part numbers 18,  28, 

68
System Configuration menu 82
system DMA 91
system fan 82
system IDs 81
system information 80
system memory map 95

T
thermal material, replacement 75
tools required 32
top components 7
top cover

removal 60
spare part number 18,  30, 

60
TouchPad 8
TouchPad board, spare part

number 31
TouchPad bracket, spare part

number 18
TouchPad button board, spare part

number 31
TouchPad buttons 8,  9

TouchPad cable, spare part
number 18

TouchPad components 8
TouchPad scroll zone 8
transporting guidelines 35

U
Universal Serial Bus (USB) legacy

support 78,  82
unknown password 37
USB board, removal 63
USB connector and cable, spare

part number 18
USB connectors, spare part

number 28
USB port

location 12,  13
pin assignments 126

V
vents 13,  14

W
webcam light, identifying 7
webcam, identifying 7
Windows applications key 11
Windows Backup utility 120,  121
Windows logo key 11
Windows recovery 117,  121
wireless antenna,

disconnecting 44
wireless antennae 7
wireless button 10
wireless light 10
wireless, product description 3
WLAN module

removal 43
spare part number 28
spare part numbers 19,  27, 

43
WLAN module compartment 14
WLAN module compartment cover

illustrated 22
removal 44

workstation guidelines 35
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